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1 INTRODUCTION

The purpose of the “Keyword tool” application is to allow generating multiple combinations of
keywords which you can further filter and create a final list. This list can be saved or exported as a
file.

This document is a detailed guide for using the “Keyword tool” application. Instructions for each of
the options are located in appropriate sections of this document

1.1 Installation Procedure

In order to begin installing the “Keyword Tool” double click the “Keyword Tool.exe” file. The
“Welcome” screen will be displayed.

{5 Setup - Keyword Tool =101 x|

Welcome to the Keyword Tool
Setup Wizard

Thiz will inztall Kewword Tool on pour computer.

It iz recormmended that you cloze all other applications befare
continuing.

Click, Mest to continue, or Cancel to exit Setup.

Cancel |

Figure 1: Installation procedure (step 1/5)

Click on the “Next” button and the screen for setting the destination location will be displayed.
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]inEl Setup - Keyword Tool

Select Destination Location
Where should E.eyword Taoaol be installed?

‘J Setup will ingtall Keyward T ool into the fallowing folder.

To continue, chck Mesxt. IF you would like to select a different folder, click Browse.

eyward T oo Browze. .. |

At leazt 0.9 MB of free disk space iz required.

< Back I Hext > I Cancel

Figure 2: Installation procedure (step 2/5)

Leave the default location or choose a custom one by clicking on the “Browse” button. After setting
the desired location, click on the “Next” button and the screen for selecting the desired start menu

folder will be displayed.

]inEl Setup - Keyword Tool

Select Start Menu Folder
Where should Setup place the program's shartcuks?

Setup will create the program's shartcuts in the following Start Menu folder.

To continue, chck Mesxt. IF you would like to select a different folder, click Browse.

Browze. .. |

< Back Hext > Cancel

Figure 3: Installation procedure (step 3/5)

Choose the desired start menu folder and click on the “Next” button. The following screen will be
displayed.
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]inEl Setup - Keyword Tool

Ready to Install
Setup iz now ready to begin installing Kemward Toal on your camplker.

Click. Inztall ko continue with the installation, or click Back if wou want to review or
change any settings.

Destination location; :l
:AProgram Fileshkemyard Tool

Start benu folder:
F.ewvord Tool

Figure 4: Installation procedure (step 4/5)

Click on the “Install” button inside this screen and the installation will be begin. After a few
moments, the screen with the confirmation on the successful installation will be displayed.

{5 setup - Keyword Tool o ] S

Completing the Keyword Tool
Setup Wizard

Setup haz finizhed installing Keyward Tool on wour computer.
_The application may be launched by selecting the installed
icoh.

Click Firish to exit Setup.

Figure 5: Installation procedure (step 5/5)

Click the “Finish” button to close the installation program.
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2 KEYWORD TOOL INTERFACE

This section of the document will give the definition of the “Keyword tools” interface. The interface
contains the following elements:

e Word Lists — panel used for entering keywords that will be combined inside the generated
list panel once you click the “Generate” button and menu (see section 2.4 for details on
menu options)

e Generated List — panel where the generated combinations of keywords are displayed and
menu (see section 2.5 for details on menu options)

e Master List — panel where master list of keywords is displayed and menu (see section 2.6
for details on menu options)

§ Keyword Tool =10l x|

File ‘Word Lists Generated Master List Help
E.ﬁ.dd Wiard Lisk @Generate - @List Toals = @.ﬁ.dd ko Master @Master Toals =

Paintings ﬂ =
Silk:
arkisk
Scarve

=
@Required| o O | ==

paintings an silk ﬂ
silk. paintings

silk artisk

silk scarves

@Required| o O | p=

|

=l

=

Figure 6: Keyword Tool Interface

Read the next section for instructions on how to generate the keywords list.

2.1 Generating keyword list

In order to generate the password list, put as many single words as you like inside the “Word Lists”
panel and click on the “Generate” button.
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§ Keyword Tool =10l x|

File ‘Word Lists Generated Master List Help

E.ﬁ.dd Wiard Lisk |§Generate "I @List Toals = @.ﬁ.dd ko Master @Master Toals =

Paintings j =
Silk:
arkisk
Scarve

- [~
@Required| Q @ |

paintings an silk j
silk. paintings
silk artisk

silk scarves

@Required| Q @ |

.

Figure 7: Generating keyword list (step 1/3)

Other options inside this page are:
e Add Word List — option for adding a new Word List Box

e Required — button for toggling between optional and required word lists (see section 2.2
for further information)

Once you define the desired keywords and click on the “Generate” button inside the “Word Lists”
panel, the “Generated Lists” panel will be filled with the generated keyword combinations.
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g Keyword Tool
File Word Lisks

E.ﬁ.dd Wiard Lisk @Generate -

Generated  Master Lisk

Help

@List Tools I: Q.ﬁ.dd ko Masterl

@Master Tools =

Paintings
Silk:
arkisk
Scarve

@Required| Q @ |

paintings an silk
silk. paintings
silk artisk

silk. scarves|

@Required| Q @ |

EE

Paintings paintings on silk
Paintings silk paintings
Paintings silk artisk
Paintings silk scarves
Silk. painkings an silk
Silk. silk. paintings

Silk: sill:. artist

Silk: sill: scarves

Artisk paintings an silk,
Artisk silk paintings
Artist silk. artisk

Artisk silk scarves
Scarve paintings an silk
Scarve silk paintings
Scarve silk artisk
Scarve silk scarves

Generaked Ikems | 16

Masker

Figure 8: Generating keyword list (step 2/3)

The following are the options inside the “Generated List” panel:

e List Tools — options for managing keywords inside the “Generated List” such as “select
all”, “copy”, “save”, etc. (see section 2.5 for further details, since the options inside the

“Generated” menu are identical)

e Add to master — button for adding the selected keywords to the “Master List”

Select the desired generated keywords inside the “Generated List” panel and click on the “Add to

Master” button.
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& Keyword Tool
File Word Lisks

Eﬂdd ‘Ward List @Generate -

Generated  Master Lisk

Paintings ﬂ =
Silk:

arkisk

Scarve

Help

@List Toals = @.ﬁ.dd ko Master

@Master Tools -

Paintings paintings on silk,
Paintings silk. painkings
Paintings silk. artist

@Required| o O | ==

Paintings silk scarves
Silk. paintings on silk,
Silk silk. paintings

Silk silk, artisk

@Required| o O | p=

paintings on silk ﬂ Silk silk: scarves

silk. paintings Artist paintings on silk
silk. artist Artist silk. paintings
silk scarves

Artist silk, artisk

Artist silk, scarves
Scarve painkings on silk
Scarve silk. paintings

Scarve silk. artisk
Scarve silk scarves

EE

Master Lisk Ik

Generaked Ikems | 16

Figure 9: Generating keyword list (step 3/3)

The selected keywords will be added to the “Master List”, where you have the following options
inside “Master Tools” menu:

Select All - option for selecting all keywords inside the “Master List”
Copy To Clipboard - option for copying the selected keywords into clipboard

Paste From Clipboard - option for pasting the copied keywords from the clipboard (note:
the copied keywords can be pasted into any textual file)

Load From File - option for loading the keyword list from a previously saved file

Save To File - option for saving the selected keywords from the “Master List” into a file
Delete Selected - option for deleting the selected keywords

Clear List - option for clearing the “Generated List”

Add Single Item — option for subsequently adding a new keyword or keywords into a
master list (see figure below)

This completes the procedure of generating the keywords.

2.2 Using Required/Optional word list

There are two possible modes of the word list and those are (note: click on the “Required” or
“Optional” to toggle between two modes):

Required — if this option is selected in the word list, the entered keywords will appear in
every phrase in the results

Optional — if this option is selected for the word list, the entered keywords will appear in
the results, but not in every phrase
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o0 Note: once you choose optional mode for word list you also have the following
options:

o] Q - Button for moving the optional word list up

o] 5 - Button for moving the optional word list down

o =- Option for clearing the optional word list

& Keyword Tool

File waord Lists

Generated  Master Lisk

E.ﬁ.dd ‘Ward List @Generate -

Help
@List Tools = @.ﬁ.dd ko Masker

@Master Tools -

Paintings
Silk
Arkist
ScCarve

4 || |Paintings paintings on silk
Paintings silk paintings
Paintings silk, artist
Paintings silk scarves

Silk. paintings on silk

Paintings paintings on silk
Paintings silk. paintings
Paintings silk. arkisk
Paintings silk scarves

Silk, paintings on silk,

[

Silk. sill paintings
Silk sill: artist:
;I Silk. sill: scarves

Silk silk. paintings

@Required| Q @ | =

paintings an silk,

:Silk sill artist
Silk, silk, scarves

silk. paintings Artist paintings on silk Artist painkings on silk:
s?lk artisk Artist silk paintings Artist silk paintings
silk. scarves Artist sill, artist artist sill, artist

Artist sill: scarves
Scarve paintings on silk
Scarve silk paintings
Scarve sill artisk
acarve sillk scarves

j Artist sill scarves
Scarve paintings on silk

Scarve silk paintings

ﬂ Scarve silk artisk
Scarve silk scarves

QOptiDnal | Q @ | =

jll Generaked Ikems § 16 Master Lisk II

Figure 10: Example of Required/Optional word lists

2.3 Using the File Menu

This section will give detailed instructions on using the file menu and all available options.

¢ Keyword Tool

File ‘WordLists Generated Master List  Help

[% Load Lists Fram File. .. @List Tools - @.ﬁ.dd ko Master

b save Lists To File. ., Paintings paintings on silk,
Paintings silk paintings
Paintings silk. artist
Paintings =ik scarves

2 Clear all Lists...

I Exit
|
|®Required| o O | p="

Figure 11: Using the File menu

Alt+F4

The following are the options inside the “File” menu:

e Load Lists From File — option for loading the keyword list from the previously saved file
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e Save Lists To File —option for saving the keyword list into a txt file
e Clear All Lists —option for resetting all lists

e Exit — option for exiting the application

2.4 Using the Words Lists Menu

This section will give detailed instructions on using the “Words Lists” menu and all available
options.

§# Keyword Tool
File | Word Lists @enerated  Master List  Help

EJ E Add WWaord List ate - @List Tools - @.ﬁ.dd ko Master
Pail @ BereelE Fa ﬁ; Painkings paintings on silk
Silk: Paintings silk paintings
Artisk Painkings silk artist
Searve Paintings silk scarves
ﬂ Silk. painkings on silk
Silk. silk. paintings
@Required | @ @ | = Silk. silk, artist

Figure 12: Using the Word Lists menu

The following are the options available inside the “Word lists” menu:
e Add Word List — option for adding a new word list box

e Generate — option for generating keyword combinations

2.5 Using the Generated Menu

This section will give detailed instructions on using the “Generated” menu and all available options.

i Keyword Tool
File ‘Word Lists | Gemerated Master List  Help

o add word List. Add Ta Master bList Tools + {gAdd to Master
Paintings Selact Al Binkings paintings an silk
Silk: ) Binkings silk paintings

) Copy To Clipboard
Artisk Py . . ainkings silk artisk
Scarve Paste From Clipboard Lirtings silk scarves
@ Load From File. . I pintings o silk
; ¢ silk paintings
} rm = Ta File. ..
@Requlred | H ave Tn e k. silk. artist

m Delete Selected b silk. scarves
s?lk paintings 5 Clear List... kist paintings on silk
silk artisk rerettist silk paintings

Figure 13: Using the Generated Menu

The following are the options inside the “Generated” menu:

e Add To Master — option for adding the selected keywords from “Generated List” to “Master
List”

e Select All — option for selecting all keywords inside the “Generated List”

e Copy To Clipboard — option for copying the selected keywords into clipboard
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Paste From Clipboard — option for pasting the copied keywords from the clipboard (note:
the copied keywords can be pasted into any textual file)

Load From File — option for loading the keyword list from a previously saved file
Save To File — option for saving the selected keywords from the “Generated List” into a file
Delete Selected — option for deleting the selected keywords

Clear List — option for clearing the “Generated List”

2.6 Using the Master List Menu

This section will give detailed instructions on using the “Master List” menu and all available options.

& Keyword Tool

File ‘Word Lists Germerated | Master List  Help

Tladd word List  (QYGener  Select Al + (@ Add to Master
Paintings Copy To Clipboard frgs on silk
Silk. Paste From Clipboard Sinkings
Artisk ik
SCarve @ Load From File.. . Srves
H Save Tao File. .. A silk

Dreqired | @ Delete Selected

2 Clear List..,
paintings an silk, _
s!lk paintings add Single Ttem... o silk,
silk. artist T — P

Figure 14: Using the Master List Menu

The following are the options available inside the “Master List” menu:

Add Single Item x|

Enter item :

Select All - option for selecting all keywords inside the “Master List”
Copy To Clipboard - option for copying the selected keywords into clipboard

Paste From Clipboard - option for pasting the copied keywords from the clipboard (note:
the copied keywords can be pasted into any textual file)

Load From File - option for loading the keyword list from a previously saved file

Save To File - option for saving the selected keywords from the “Master List” into a file
Delete Selected - option for deleting the selected keywords

Clear List - option for clearing the “Generated List”

Add Single Item — option for subsequently adding a new keyword or keywords into a
master list (see figure below)

|Silk paintings

0k, I Cancel

Figure 15: Adding a single item
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2.7 Using the Help Menu

The help menu contains the information on the application version.

i Keyword Tool
File ‘WaordLists Generated Master Lisk

E.ﬁ.dd ‘Ward List @Generate -

Help

@adato s

@Required| Q @ | =

Figure 16: Using the Help Menu

Paintings ﬂ 4 || |Paintings paintings on silk.
Silk Paintings silk paintings
firtisk Paintings silk. artist
Scarve

Paintings silk scarves
Silk. painkings on silk
Silk. silk. paintings

Silk: sill:. artist

Click on the “About” button to see the version information.

K@ﬂw

ool

Versionai)

Keyword Tool
Yersion 1.0

Copyright () 2005 Xvhercode, Inc

All rights reserved.

Figure 17: Application version

2.8 Uninstalling Keyword tool

In order to uninstall “Keyword tool”, navigate to “Keyword tool” folder inside the “Start menu” and
choose the “Uninstall Keyword tool” option.
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Programs @ Accessories
) Games b
£ Documents » @ Skype .

il REALHOUND TP

G-“ Settings b
™) dbMagic

;--} Search v I
) site searcher ¥ fi5

Help and Suppork

w
L

Run...

Log Off gaza. ..

Windows XP Professional
0 &

OIS

Turn QOff Computet, .,

Figure 18: Uninstalling “Keyword Tool” (step 1/3)
The following dialog will be displayed.

Keyword Tool Uninstall ]

M_?/H Are you sure you wank to completely remove Keyword Tool and all of its components?

Figure 19: Uninstalling “Keyword Tool” (step 2/3)
Click on the “Yes” button to confirm and the following dialog will be displayed.

Keyword Tool Uninstall x|

L.
\!:) Keyword Tool was successfully removed From your compuker,

Figure 20: Uninstalling “Keyword Tool” (step 3/3)

Click the “OK” button to complete the uninstall procedure.
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